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Using the 2006 Club Tax Printer 
This Tax Printer program works with data from ICLUBcentral’s Club Accounting 
software, performing certain calculations, and then generating tax forms with these 
calculated values. The program does not alter your original club data stored in the 
Club Accounting software. To properly use this program, make sure your account-
ing records are up-to-date first!  

System Requirements 
Use of this software requires at least: 

• A compatible Windows operating system (Windows 2000/Windows XP) 
• 128 MB of RAM minimum (256 MB recommended). 
• 30 MB of free hard drive space. 
• Adobe Acrobat 6.0 (required to process PDF files). Adobe Acrobat can be 

downloaded free of charge from http://www.adobe.com. 
• Club Accounting version 3.1 (CA3.1) or higher. 

Installing the Club Tax Printer 
To install the program there are two installation options, CD or Download: 
If you have received a CD: 

• Insert the CD into your computer’s CD-ROM drive. The installation pro-
gram should launch automatically. 

http://www.adobe.com
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If you are downloading the program from the Internet: 
• The installation program should launch automatically if you select Open.  
• If you choose not to allow automatic installation, or choose to Save, you 

can install the program manually by clicking on the 2006 Club Tax Printer 
Setup icon.  

Preparing the Club Data 
Before generating your tax forms, you should make sure that your club accounting 
data is properly prepared. We recommend that you wait until you have all the nec-
essary data and have performed a reconciliation of all the partnership accounts be-
fore completing your taxes. Necessary data includes your year-end brokerage firm 
and bank statements, including details of all buy, sell, dividend, interest, service 
charge and other transactions for the entire year through December 31, 2006. It is 
likely that you will not have this information until mid- to late January. 
Once you have all the necessary data and the club has conducted their annual audit, 
close out the books for the year: 

1) Launch Club Accounting. 
2) Select Tools > Year-end Tasks from the menu. Follow the instructions to 

close your books for the year. 
3) Exit the program. 

Running the Club Tax Printer 

 
The Club Tax Printer does not operate as a separate program on your computer. 
Instead, it is installed as part of your Club Accounting 3 software. To use the Club 
Tax Printer, simply select Taxes from the Club Accounting 3 menu to prepare your 
tax filings. 
If you have multiple clubs set up in your Club Accounting software, each time the 
Tax Printer is launched, you will need to select which club you wish to work with 
from a list of club names. If you would like to use the Tax Printer program to gener-
ate tax forms for several clubs, you will need to purchase a Tax Printer serial num-
ber for each club. See http://www.iclub.com for more information on how to pur-
chase additional serial numbers. 

http://www.iclub.com
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Registration 
When starting the tax printer for the first time, 
you will see the registration window. You 
must register your program over the Internet 
with your Tax Printer serial number before it 
is usable. 
Your Tax Printer serial number (beginning 
with CTW) is proof that you purchased a li-
cense to use this program. It is included with 
your Tax Printer packaging. 
If you purchased the downloadable version of 
this program, your Tax Printer serial number 
will be provided to you via email. 

Entering Your Club Information 
Once you have registered, over the next three screens you will be prompted to enter 
information about your club that is necessary to generate your club’s tax forms. 
Step 1: 

• Club Address: Enter your club’s legal address as registered with the IRS.  
• Date business started: The date that your club formed as a partnership.  
• Check the Amended Return box only if you are filing an amended return. 
• Type of partnership: Most clubs are formed as general partnerships.  

Select Next. 
Step 2: 

• Are any partners in this partnership also partnerships? 
Mark appropriately. Most clubs will leave this unchecked. 

• Is this partnership a partner in another partnership? 
Mark appropriately. Most clubs will leave this unchecked.  

• Did the partnership file Form 8893, Election of Partnership Level Tax 
Treatment, or an election statement under section 6231(a)(1)(B)(ii) for 
partnership-level tax treatment, that is in effect for this tax year? 
If your club had ten or fewer partners throughout the 2006 tax year (hus-
band and wife count as one partner; no partners being non-resident aliens, a 
C corporation, or the estate of a deceased partner), you may elect to answer 
Yes to this question. If you select yes, Form 8893 will be generated by the 
software (file with your return when complete), also enter your designated 
TMP information below. (If you previously filed Form 8893 with the IRS, 
check the box, enter your TMP information below but do not file 
8893.) You may also choose not to make this election. See IRS 1065 in-
structions page 20 for more detail. 
If your club had more than ten partners at any time during the 2006 tax 
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year (see guidelines above) then your club is already subject to Partnership 
Level Tax Treatment. Leave this box unchecked. You may still provide the 
name of your club's designated TMP below if desired. 

o The name of the Tax Matters Partner (TMP) 
o The identifying number (Social Security number) of the TMP. 
o In the upper box, enter the street address. 
o In the lower box, enter the city or town, state and ZIP code. 

Step 3: 

• Does this partnership have any foreign partners? 
Mark appropriately. Most clubs will leave this unchecked. 
Select Next. 

• Is this partnership a publicly traded partnership as defined in section 469? 
Mark appropriately. Most clubs will leave this unchecked. 

• Has this partnership filed, or is it required to file, Form 8264, Application 
for registration of a Tax Shelter? 
Mark appropriately. Most clubs will leave this unchecked. 

• At any time during the calendar year 2006, did the partnership have an in-
terest in or a signature or other authority over a financial account in a for-
eign country (such as a bank account, securities account or other financial 
account)? See page 20 of the instructions for exceptions and filing re-
quirements for Form TD F 90-22.1. If "Yes” enter the name of the foreign 
country: 
Fill-in appropriately. Most clubs will leave this blank.  

• During the tax year, did the partnership receive a distribution from, or was 
it the grantor of, or transfer or to, a foreign trust? If "Yes", the partnership 
may have to file additional forms. See page 20 of IRS Form 1065 instruc-
tions. 
Mark appropriately. Most clubs will leave this unchecked. 

• Was there a distribution of property or a transfer of interest during tax 
year? 
If your club had a partial or full withdrawal by a member during the tax 
year, you would check this box. Even though tax law permits you to make 
an election to adjust the tax basis of club assets, this software does not 
support election of Section 754. 

IRS Center: 
Investment clubs are partnerships, and do NOT send their tax forms to the 
same place as individuals. Choose the appropriate IRS center for your club 
from the drop down list. If you do not know where to file, just click on the 
convenient reminder "Where do I file?" button. The text below is the same 
as the text accessible when running the Tax Printer. Note that no street ad-
dress is required in order for mail to reach the IRS centers. 
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Where to send your forms: 

If your club is based in: Connecticut, Delaware, District of Columbia, Illi-
nois, Indiana, Kentucky, Maine, Maryland, Massachusetts, Michigan, New 
Hampshire, New Jersey, New York, North Carolina, Ohio, Pennsylvania, 
Rhode Island, South Carolina, Vermont, Virginia, West Virginia, Wiscon-
sin 
Then your club sends its return to: Internal Revenue Service; Cincinnati, 
OH 45999-0011 

If your club is based in: Alabama, Alaska, Arizona, Arkansas, California, 
Colorado, Florida, Georgia, Hawaii, Idaho, Iowa, Kansas, Louisiana, Min-
nesota, Mississippi, Missouri, Montana, Nebraska, Nevada, New Mexico, 
North Dakota, Oklahoma, Oregon, South Dakota, Tennessee, Texas, Utah, 
Washington, Wyoming 
Then your club sends its return to:  Internal Revenue Service; Ogden, UT 
84201-0011 

If your club is based in: A foreign country or possession. 
Then your club sends its return to: Internal Revenue Service; Philadelphia, 
PA 19255-0048 

Select Next. 

Generating Your Tax Forms 
Step 4: 
You are now ready to print your Club Tax Returns. We recommend that you gener-
ate a complete return and extra copies of Schedule K-1’s for each member. Check 
the appropriate boxes to print the Form 1065 and Schedule D. 
The scrollable window lists each member active during the Tax year. A Schedule K-
1 prints for each club member highlighted in the list. 
 
Creating PDF files: Selecting Finish will launch Adobe Acrobat Reader and gen-
erate the forms in PDF format. From Adobe Acrobat Reader, you can save a copy of 
the files to your computer or print them directly. 
 
Printing your tax forms: To print tax forms, click on the printer icon or go to the 
File > Print menu item after you’ve created a PDF file copy of your club’s tax re-
turn. 
 
Saving your tax forms: To save your tax forms in PDF format, click on the disk 
icon or go to the File > Save menu item. The files will be saved in Adobe’s PDF 
format. You may read these at anytime using the Adobe Acrobat Reader. 
 
Additional notes: A Tax ID number for each member is required for the club’s tax 
returns to be complete. If the message No Tax ID Entered shows up next to a mem-
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ber’s name, that member’s Social Security Number was not entered in Club Ac-
counting. Fill it in by hand after you have printed the appropriate tax form. 
Select Quit to exit the Tax Printer. 

Forms and Schedules Printed 
The 1065/K-1 software prints the following forms and schedules: 

• Form 1065: U.S. Partnership Return of Income, pages 1-4 
• Schedule D (Form 1065): If your club has no capital gains or losses for 

the year, this schedule is unnecessary and will not be printed. There also 
may be supplemental pages printed. 

• Supporting schedules for Schedule K: Partners' Shares of Income, Cred-
its, Deductions, etc. There also may be supplemental pages printed. 

• Schedule K-1 and K-1 Instructions: For each partner 
• Form 8893: Only if chosen as per Step 2, question 4. 

Not all pages of Form 1065 and associated schedules will contain data. In most 
cases, the first page of Form 1065 contains no data except identification, date in-
formation, and the number of attached Schedule K-1s. 
Note: If required Schedules L, M1, and M2 must be filled out manually. Please see Common 
Problems & Release Notes on page 6. 

What You Need to Send to the IRS 
2006 Club Tax Printer software prints IRS acceptable schedules required for filing 
your club’s tax return. Investment clubs should file with the appropriate IRS service 
center, one copy each of: 

1) Form 1065 (plus Schedule D and any supplementary schedules) 
2) A Schedule K-1 for each member. 

Note: If your club has no gains or losses on the year, the tax software will not print Sched-
ule D. If this is the case, you do not need to file Schedule D. 

What You Need to Give to Your Members 
Club members must receive a copy of their respective Schedule K-1s for use in pre-
paring their personal tax returns. This includes members who withdrew from the 
club during the year. This copy is kept with their tax records; it is not filed. You 
must also give one copy of the K-1 instructions, found on page 2 after you generate 
your complete forms. 

What You Need to Keep for Club Records 
The club should keep a copy of the full Form 1065, Schedule D (if prepared), each 
Schedule K-1, and any additional supporting statements and attachments as part of 
its permanent records.  
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Common Problems and Release Notes 
• 2006 Club Tax Printer requires registration before the program can be run. Reg-

istration can be done over the Internet from within the registration screen. 
• If you find the program taking a long time to load your Adobe Acrobat Reader 

and Tax Forms, your computer may lack sufficient memory or free hard drive 
space. Select fewer forms to print faster, and then repeat this process for the 
remaining forms. 

• The 2006 Tax Printer, in accordance with IRS regulations, does not print zeros 
(0) on form spaces where the input value is zero. Instead, the Tax Printer leaves 
these fields blank. 

• Many fields on the tax forms will be blank and are intended to be blank. The 
same forms your club uses are used by partnerships that own property and have 
payrolls, neither of which applies to your investment club. Related fields are 
therefore blank. 

• Pertinent IRS forms, publications, and instructions are on the CD and in the 
program folder after installation. 

• If your club had assets with a cost basis of $600,000 or more, or had income of 
$250,000 or more, some schedules must be completed manually. Clubs having 
either of these conditions should seek tax advice from a certified tax preparer. 

• The 2006 Tax Printer does not support the 754 Election.  
• The 2006 Club Tax Printer software uses industry standard Adobe Acrobat 

software to generate your tax forms. A free copy of Adobe Acrobat Reader in-
stalls with the tax program, and can also be downloaded from 
http://www.adobe.com.  

• The 2006 Club Tax Printer will correctly allocate qualifying and non-qualifying 
dividends ONLY if all of the following conditions are met: 
• All dividends linked to securities are entered properly in Club Accounting  
• Ex-dividend dates are entered for all common stock dividends in CA.  
• REITs, mutual funds, and "other" (Limited and Publicly Traded Partner-

ships, etc.) securities are correctly identified 

Help from ICLUBcentral 
Technical Support is available on our web site at http://www.iclub.com/support. 
You may ask specific questions via our web form and review the Frequently Asked 
Questions section of the web site as well.  

If you cannot solve your problem using online help, the most efficient way to con-
tact an ICLUBcentral Technical Support Representative is to use our web help 
forms located at http://www.iclub.com/support/. Our experts will then easily be able 
to retrieve and reply to your question or problem quickly and efficiently.  

Answers to questions about installation of the Club Tax Printer are included with 
your purchase of the software. Questions about club accounting principles, tax is-
sues, and the Club Accounting software are covered by your Maintenance Agree-

http://www.adobe.com
http://www.iclub.com/support
http://www.iclub.com/support/
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ment. To receive full coverage, you must purchase Accounting Software Mainte-
nance and renew it annually.  

Requesting Technical Support: 
 

To our Treasurers, 
 

Each year, your club’s members look to you to make sure their taxes 
are filed in time. And each year, from December to March, ICLUB-
central’s call volume triples. We bring in extra help, update the FAQs, 
and give it our all to answer your questions. Your patience during this 
time is appreciated. Here’s looking forward to a successful tax sea-
son! 
 

Daniel R. Abraham 
Director of Technical Support, ICLUBcentral Inc. 
 

Use the guide to help our experts quickly answer your questions. Write down the 
precise wording of any error message displayed when you have a problem, includ-
ing the names of any files mentioned in the message. Be familiar with: 

• The version of Windows you are using. 
• The make, model and amount of memory (RAM) on your computer.  
• The make and model printer if you have a question regarding the printing 

of reports. 
• Note your Club Tax Printer serial number and purchase/installation date. 

User License and Support Agreement (ULSA)  
Applicable to the 2006 Club Tax Printer. Use of this product is governed by terms 
of a User License and support Agreement or ULSA. 
THIS LICENSE AND SUPPORT AGREEMENT (THE "AGREEMENT") IS A LEGAL CONTRACT 
BETWEEN YOUR INVESTMENT CLUB OR YOU IN YOUR INDIVIDUAL CAPACITY, AS THE 
CASE MAY BE AS INDICATED IN THE PRECEDING PARAGRAPH (COLLECTIVELY, "YOU") 
AND ICLUBCENTRAL INC. ("ICLUBCENTRAL"). BY CLICKING ON “ACCEPT” WHEN YOU 
INSTALL THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE TERMS AND CON-
DITIONS OF THIS AGREEMENT, INCLUDING WITHOUT LIMITATION THE CUSTOMER SUP-
PORT PROVISIONS SET OUT BELOW. IF YOU DO NOT AGREE TO SUCH TERMS AND CON-
DITIONS, YOU MUST PROMPTLY RETURN THE SOFTWARE ICLUBCENTRAL OR ITS SOFT-
WARE DISTRIBUTOR, IN ORDER TO RECEIVE A FULL REFUND OF THE LICENSE AND 
CUSTOMER SUPPORT FEES THAT YOU HAVE PAID. If You should have any difficulty in obtain-
ing such refund, please contact ICLUBcentral at 1430 Massachusetts Ave, 3rd Floor, Cambridge, MA 
02138. 
THE ENCLOSED COPY OF THE 2006 CLUB TAX PRINTER, INCLUSIVE OF ALL ADD-ONS 
AND FUTURE RELEASES, (the "SOFTWARE"), AND THE RELATED DOCUMENTATION, IN-
CLUSIVE OF ALL FUTURE RELEASES (the "DOCUMENTATION"), ARE EACH LICENSED TO 
YOU WITH A NON-EXCLUSIVE AND NON-TRANSFERABLE RIGHT, EXCEPT AS ALLOWED 
BELOW UNDER 'PERMITTED USES', TO USE ONLY UNDER THE FOLLOWING TERMS AND 
CONDITIONS: 
PERMITTED USES 
You MAY: Install the Software on a storage device in Your computer, as set forth in the instructions 
contained in the Documentation. Note: The Software has been designed to only allow it to be used for a 
single individual in Your investment club on a single personal computer. 
NON-PERMITTED USES 
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You MAY NOT: 
• Make any copies of the Software. 
• Make any copies of the Documentation. 
• Disclose, rent, license, sublicense, lease, sell, lend, disseminate or otherwise distribute the 

Software or the Documentation.  
• Network the Software or otherwise use it on more than one computer or computer terminal at 

the same time. 
• Use the Software to conduct a service bureau, application service provider ("ASP") business 

or similar business for the benefit of third parties. 
• Transfer Your rights under this Agreement. 
• Alter, enhance, supplement, create derivative work therefrom, translate, decompile, disassem-

ble, reverse engineer or otherwise reduce the Software to human readable form. 
• Remove or obscure the copyright and trademark notice on the label of the storage medium 

containing the Software or in the Documentation. 
TERMINATION/DURATION 
This Agreement and Your license to use the Software and the Documentation will automatically termi-
nate without notice from ICLUBcentral and without any pro rata abatement of the license and customer 
support fees You have paid if You fail to comply with any term or condition of this Agreement or upon 
your giving written notice of termination to ICLUBcentral. 
This Agreement is effective from the day upon which You indicate acceptance of this Agreement. In 
order to be granted license to use this Software, you must register this Software fully and accurately with 
ICLUBcentral and receive a valid confirmation of registration from ICLUBcentral. The license then 
granted will continue until either You terminate this Agreement by giving written notice of termination to 
ICLUBcentral; or this Agreement is terminated by ICLUBcentral, as provided in the immediately preced-
ing paragraph. 
CUSTOMER SUPPORT PROVISIONS 
Included in the total fee that You have paid for the Software and the Documentation is an amount that 
covers limited customer support services as described in this Agreement (the "Customer Support Ser-
vices"). ICLUBcentral will provide limited Customer Support Services for the length of time described 
below in the section headed ‘Support Termination/Duration’ during the term of this Agreement.  
Customer Support Obligations of ICLUBcentral: 
Provide customer support for the Software only if (i) You have performed the online Product Registra-
tion as provided by ICLUBcentral in order to register the Software; and (ii) Your copy of the Software is 
identified with a valid serial number, and Registration Code. 
Investigate and identify any problem reported by You to ICLUBcentral that is related to the then current 
release of the Software, and correct or provide within an appropriate time, as determined by ICLUBcen-
tral, either (i) a workaround for any programming error in the then current release of the Software which 
You have identified, provided that the error is directly attributable to ICLUBcentral, or (ii) a resolution to 
the problem which You have identified (collectively the “Code Correction Services”). 
Related Obligations of End-User: 

• Use only the then current release of the Software during the term of this Agreement. 
• In the event of (i) a problem with the Software that results in either a system crash or loop; or 

(ii) a situation where You can reasonably demonstrate that the Software produces an errone-
ous arithmetic result that is not a function of incorrect or improper input data, then You must 
submit to ICLUBcentral a written report of all input and keystrokes to the Software giving 
rise to the problem. 

Support Termination/Duration: 
Answers to questions about installation of the Club Tax Printer are included with your purchase of the 
software. Questions about club accounting principles, tax issues, and the Club Accounting software are 
covered by your Club Accounting Maintenance Agreement. To receive full Customer Support coverage, 
you must purchase a Club Accounting Maintenance Agreement and renew it annually.  
 
LIMITED WARRANTY 
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ICLUBcentral does not have control over the conditions under which You use the Software and does not 
and cannot warrant the performance or results that may be obtained by its use. However, ICLUBcentral 
warrants that the Software will perform substantially in accordance with the Documentation for a period 
of ninety (90) days from the date the product was shipped to You, provided that the Software is used on 
the computer equipment, operating system and in the environment for which it was designed and config-
ured. Your sole remedy and ICLUBcentral ‘s exclusive liability under the foregoing limited warranty will 
be the furnishing by ICLUBcentral, within a reasonable period of time and without charge, of the Cus-
tomer Support Services pursuant to the Customer Support Services provisions of this Agreement. To 
bring a claim under this limited warranty, You should contact Support Department at ICLUBcentral, 
1430 Massachusetts Ave, 3rd Floor, Cambridge, MA 02138 to obtain information on warranty perform-
ance; You must be given a Return Authorization Number by ICLUBcentral before returning the Software 
to ICLUBcentral. Some jurisdictions do not allow the exclusion or limitation of relief, incidental or con-
sequential damages, so the above limitation or exclusion may not apply to You. 
Because computer programs are inherently complex, You are advised to always verify Your work and 
periodically (after each use) back up the data You have created with the Software. 
ICLUBcentral does not warrant that any of the Software, the Documentation or Customer Support Ser-
vices to be provided pursuant to this Agreement will meet Your requirements. The only warranty made 
with respect to the Software is the limited warranty set forth in this Agreement. 
EXCEPT AS SO SPECIFICALLY PROVIDED ABOVE IN THE IMMEDIATELY PRECEDING 
PARAGRAPH, THERE ARE NO WARRANTIES, REPRESENTATIONS, OR CONDITIONS MADE 
BY ICLUBCENTRAL OR ANY OTHER PERSON INVOLVED IN THE CREATION, PRODUCTION 
OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUP-
PORT SERVICES, EITHER EXPRESS OR IMPLIED, WITH RESPECT TO THE SOFTWARE, THE 
DOCUMENTATION, ANY RELEASES THERETO, OR THE CUSTOMER SUPPORT SERVICES 
INCLUDING THEIR RESPECTIVE QUALITY, PERFORMANCE, MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. Notwithstanding the above, where 
applicable, if You qualify as a “consumer” under the Magnuson-Moss Warranty Act, then You may be 
entitled to any implied warranties allowed by law for the period of the express warranty as set forth 
above. Some states do not allow limitations on how long an implied warranty lasts, so the above limita-
tion may not apply to You. This warranty gives You specific legal rights, and You may also have other 
rights which vary from state to state. 
LIMITATIONS OF LIABILITY; INDEMNIFICATION 
NEITHER ICLUBCENTRAL NOR ANY OTHER PERSON INVOLVED IN THE CREATION, PRO-
DUCTION, DISTRIBUTION OR SUPPORT OF THE SOFTWARE, THE DOCUMENTATION OR 
THE CUSTOMER SUPPORT SERVICES WILL BE LIABLE TO YOU OR ANY THIRD PARTY 
ARISING OUT OF THIS AGREEMENT AND/OR YOUR USE OF OR INABILITY TO USE THE 
SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES, REGARD-
LESS OF THE FORM OF THE CLAIM OR ACTION, THAT EXCEEDS THE PORTION OF THE 
FEE YOU HAVE PAID FOR THE SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER 
SUPPORT SERVICES, AS THE CASE MAY BE. 
NEITHER ICLUBCENTRAL NOR ANY OTHER PERSON INVOLVED IN THE CREATION, PRO-
DUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE CUS-
TOMER SUPPORT SERVICES WILL BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY 
SPECIAL, INCIDENTAL, CONSEQUENTIAL, EXEMPLARY DAMAGES OR OTHER INDIRECT 
DAMAGES OR LOSS OF PROFITS, LOSS OF DATA OR LOSS OF USE DAMAGES ARISING 
OUT OF THIS AGREEMENT; AND/OR 
THE MANUFACTURE, SALE, SUPPLYING OR FAILURE OR DELAY IN SUPPLYING OF THE 
SOFTWARE, THE DOCUMENTATION OR THE CUSTOMER SUPPORT SERVICES RELATED 
THERETO, EVEN IF ICLUBCENTRAL HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 
Some jurisdictions do not allow the exclusion or limitation of special, incidental, consequential, indirect 
or exemplary damages, or the limitation of liability to specified amounts, so the above limitations or 
exclusions may not apply to You. 
YOU AGREE TO INDEMNIFY AND HOLD ICLUBCENTRAL AND ALL OF THE PERSONS IN-
VOLVED IN THE CREATION, PRODUCTION, OR DISTRIBUTION OF THE SOFTWARE, THE 
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DOCUMENTATION AND THE CUSTOMER SUPPORT SERVICES HARMLESS FROM CLAIMS 
AND DAMAGES OF ANY TYPE WHATSOEVER ARISING FROM ANY THIRD PARTY AS A 
RESULT OF YOUR USE OF THE OUTPUT FROM, AND/OR YOUR INABILITY TO USE THE 
SOFTWARE OR AS A RESULT OF ANY CUSTOMER SUPPORT SERVICES PROVIDED OR TO 
BE PROVIDED UNDER THIS AGREEMENT. 
GEOGRAPHIC LIMITATION 
ICLUBcentral Customer Support Services cannot be provided at the same level to customers outside of 
the continental United States, Hawaii and Alaska. ICLUBcentral’s website is available to customers 
anywhere in the world. Email support will be provided, on a best efforts basis, to foreign customers, but 
only in English. It is understood that the ICLUBcentral products have been developed for the U.S. mar-
ketplace. 
U.S. GOVERNMENT RESTRICTED RIGHTS 
The Software and Documentation are “commercial computer software” or “commercial computer soft-
ware documentation.” Absent a written agreement to the contrary, the U.S. Government’s rights with 
respect to such Software or Documentation are limited by the terms of this Agreement, pursuant to FAR ‘ 
12.212(a) and/or DFARS ‘ 227.7202-1(a), as applicable. 
GENERAL PROVISIONS 
The Software, the Documentation, and all releases thereto are licensed to You by ICLUBcentral, and are 
protected by United States copyright laws and by international treaty provisions. Title to the Software 
and the Documentation, and patents, copyrights and all other property rights applicable thereto, shall at 
all times remain solely and exclusively with ICLUBcentral and its licensors, and You shall not take any 
action inconsistent with such title. Therefore, except for the permitted right to make one (1) back up copy 
of the Software, You must treat the Software and the Documentation like any other copyrightable mate-
rial and are precluded by law from making any copies of them. Any rights not expressly granted herein 
are reserved to ICLUBcentral and its licensors. 
The rights and obligations under this Agreement will be governed by, and any arbitration or court action 
hereunder shall apply, the laws of the Commonwealth of Massachusetts, excluding its conflicts of law 
rules, and will not be governed by the United Nations Convention of Contracts for the International Sale 
of Goods, the 1974 Convention on the Limitation Period in the International Sale of Goods (the “1974 
Convention”) and the Protocol amending the 1974 Convention, done at Vienna April 11, 1980, the appli-
cation of which is expressly excluded.  
Any dispute, controversy or claim arising out of or relating to this Agreement or to a breach hereof, in-
cluding its interpretation, performance or termination, shall be resolved in the courts of Massachusetts.  
The parties irrevocably submit to the exclusive jurisdiction of the federal and state courts of Massachu-
setts. Notwithstanding anything contained in this paragraph to the contrary, ICLUBcentral shall have the 
right to institute judicial proceedings against You or anyone acting by, through or under You, in order to 
enforce ICLUBcentral’s rights hereunder through reformation of contract, specific performance, injunc-
tion or similar equitable relief. 
If any term or condition in this Agreement is invalid or unenforceable in any respect under any applicable 
statute or rule of law, then such term or condition is modified to have the most nearly similar permissible 
economic or other effect in order to be valid and enforceable under such applicable statute or rule of law. 
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UNDERSTAND IT, AND 
AGREE TO BE BOUND BY ITS TERMS AND CONDITIONS. YOU FURTHER AGREE THAT 
THIS AGREEMENT IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE RELATION-
SHIP BETWEEN YOU AND ICLUBCENTRAL, AND SUPERSEDES ALL PRIOR OR CONTEM-
PORANEOUS PROPOSALS, ORAL OR WRITTEN, UNDERSTANDINGS, REPRESENTATIONS, 
CONDITIONS, WARRANTIES, AND ALL OTHER COMMUNICATIONS BETWEEN YOU AND 
ICLUBCENTRAL OR BETWEEN YOU ANY OTHER PERSON INVOLVED IN THE CREATION, 
PRODUCTION OR DISTRIBUTION OF THE SOFTWARE, THE DOCUMENTATION OR THE 
CUSTOMER SUPPORT SERVICES; AND THIS AGREEMENT MAY NOT BE EXPLAINED OR 
SUPPLEMENTED BY CUSTOM OR USAGE OF TRADE OR ANY PRIOR COURSE OF DEAL-
INGS BETWEEN YOU AND ANY OTHER PERSON. 
IF THERE ARE ANY CONCERNS REGARDING THIS AGREEMENT, PLEASE CONTACT: 
ICLUBCENTRAL, 1430 MASSACHUSETTS AVE, 3rd FLOOR, CAMBRIDGE, MA 02138. 


